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Executive Overview 

This white paper discusses integration of Oracle Financials Cloud with Oracle Hyperion 

Performance Management Applications including the following. 

 Oracle Data Relationship Management  

 Oracle Hyperion Planning and Budgeting 

 Oracle Hyperion Financial Management 

 

The types of information discussed in this white paper represent information typically 

shared between general ledger and financial performance management applications. 

 Chart of accounts (known as dimensions in Hyperion) values and hierarchies 

 Actual financial results 

 Budgeted amounts 

 

Some of the integration approaches discussed here can also be used to integrate Oracle 

Financials Cloud with other applications or approaches to financial management such as 

using non-Oracle applications or spreadsheets for budgeting or consolidations.   

After a review of typical information flows between Oracle Financials Cloud and the 

Hyperion applications, integration guidance is provided. 
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Introduction 

Customers pursue a variety of approaches for budgeting and consolidation, from simple 

spreadsheets to applications specifically designed for budgeting or consolidation such as 

Oracle Hyperion Budgeting and Planning Cloud Service or Oracle Hyperion Financial 

Management. 

Using Oracle Financials Cloud plus Oracle Hyperion Performance Applications or other 

solutions such as spreadsheets and non-Oracle applications, requires sharing and reusing 

information to reduce the cost of ownership and to ensure financial results are reliable for 

audits. In general terms, the types of information often shared for detailed financial 

reporting, consolidated financial reporting, and budgeting are as follows. 

 Chart of accounts and hierarchies values  

 Actual financial balances 

 Budgeted amounts 

The following sections describe recommended approaches for addressing the above 

requirements. 

Throughout this document: 

 General Ledger refers to the Oracle Fusion General Ledger capabilities within 

Oracle Financials Cloud or as an on-premise offering. 

 Planning refers to Oracle Hyperion Planning. This document covers integration of 

on-premise offerings only. Information on integration of the cloud offerings is 

covered in the white paper, Financials Cloud Integration with Planning and 

Budgeting Cloud Service. 

 Financial Management refers to Oracle Hyperion Financial Management. This is an 

on-premise solution.   

 FDM refers to Oracle Hyperion Financial Data Quality Management Enterprise 

Edition. FDM is part of Planning Cloud Service and is an optional add-on to 

Planning (on-premise) which provides robust capabilities for data transformation 

and loading. This is an on-premise solution. 

 DRM refers to Oracle Data Relationship Management. DRM is an enterprise 

change management solution for master data. It can be used to create an 

enterprise view of chart of accounts and chart of accounts hierarchies across 

general ledger and enterprise performance management systems such as Planning 

and Financial Management. This is an on-premise solution. 
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Integration Diagrams 

Data Relationship Management 

 
The relationship between Oracle Data Relationship Management, General Ledger, 

Planning, and Financial Management is as follows. 

 

 

 

 

 

 

 

 

 

 

 

 

 

DRM is a separately licensed application. It can be used to centrally manage chart of 

accounts values and hierarchies and then to export the same to other applications such as 

General Ledger. If there is not a requirement to use Data Relationship Management as a 

central repository, charts of accounts and hierarchies can be maintained directly in 

General Ledger.   

 

There is a direct integration between DRM and the on-premise Oracle Fusion General 

Ledger, but not with Oracle Financials Cloud. However, the components of the on-

premise integration, such as the application template, can be reused to integrate Data 

Relationship Management with Oracle Financials Cloud (General Ledger). This is covered 

in the DRM and General Ledger section of this white paper. 
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There are integrations between DRM and Planning (on-premise) as well as Financial 

Management. 

 

Planning  

 

The process for integrating Financials (General Ledger) with Planning and Budgeting on-

premise is captured below. If you are using the cloud offerings, see the white paper Oracle 

Financials Cloud Integration with Planning and Budgeting Cloud Service. 

 If you are using DRM, steps one and two are replaced by the process covered in the 

DRM section.   

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Chart of Accounts and Hierarchies are extracted from General ledger. They must be 
reformatted and then imported into Planning. Planning cubes are then refreshed to reflect 
this metadata. This process is completed during the initial configuration and again as 
needed to reflect updates in chart of accounts values and updates to account hierarchies. 
 

 

Planning and Budgeting and Oracle Financials 

Planning and Budgeting 
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Actual balances are extracted from General Ledger and imported into Planning. which is 
typically completed prior to generating or revising budgets? After the actual balances are 
imported, Planning business rules are run to complete aggregations of actual amounts for 
budgeting purposes. 
 
Once budgets are completed or updated the amounts are extracted from Planning, 
converted into the format required by General Ledger and imported into the same. 
 

Financial Management 

 

The process for integrating Financials Cloud Service (General Ledger) with Financial 
Management is as follows. If you are using DRM, steps one and two are replaced by the 
process covered in the DRM section.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Chart of accounts and hierarchies are extracted from General Ledger. They are 
reformatted as dimensions metadata and loaded into Financial Management. 
 
Actual balances are extracted, reformatted as required, and then imported into Financial 
Management. Financial Management is used to create consolidation rules and, in turn, 
consolidated financial balances. 
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Charts of Accounts and Hierarchies 

This section covers synchronization of chart of account and hierarchy values between 

General Ledger, DRM, Planning, and Financial Management. 

 

The suggested approach for synchronizing chart of account and hierarchy values is based 

upon whether you are using DRM to maintain your chart and hierarchy values. 

 

If you are using DRM as the source of truth for chart and hierarchy values, export the 

values from DRM and then upload them to General Ledger, Planning, and Financial 

Management.   

 

Uploading DRM values to General Ledger requires manual tasks covered in the DRM and 

General Ledger section.   

 

If you are using General Ledger to maintain chart and hierarchy values and not using 

DRM, download the values from General Ledger and then upload them to Planning and 

Financial Management. 

 

DRM and General Ledger 

 

If you are using DRM to maintain your chart and hierarchy values, you can export the 

results from DRM and then upload them to General Ledger. This process requires 

configurations. 

 

To enable this transfer, you must first update the application template used for DRM – 

General Ledger integration. This template defines the format used to export chart and 

hierarchy values from DRM to General Ledger. It also allows users to enter values for 

General Ledger specific chart of accounts purposes such as account types and start and 

end dates.    

 

The name of this template is OracleGL_DRM_AppTemplate.xml. It is available for 

download from the Oracle Enterprise Repository.  

https://fusionappsoer.oracle.com/
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Once uploaded into DRM, the following actions are necessary to export DRM chart of 

accounts and hierarchy values in the format required by General Ledger. 

 

 Create new DRM properties to map descriptive property values in DRM to single 

character codes used by General Ledger, such as for the account types. 

 Create or copy DRM export profiles. 

 Set DRM export profile parameters. Set file output options such as the 

delimiter/filename and selecting hierarchies for export. 

 Reorder DRM export columns to the order required by General Ledger. 

 Create a DRM book for each value set that is to be run from DRM and add the 

exports FusionValueSetExport and FusionHierarchyExport to the book. The 

book  runs both exports and produces two files per value set for the segment 

values and hierarchies.   

 Use DRM version variables for selecting GL related versions in DRM. 

 

After this initial configuration, use DRM to maintain account and hierarchies. Export 

these values to the .csv format required by General Ledger as needed; such as prior to 

closing the accounting period and generating financial reporting. Run the DRM book or 

exports FusionValueSetExport and FusionHierarchyExport to generate the files.   

 

The .csv files generated by DRM need to be manually loaded into General Ledger using 

the import process described in the Upload Files and Import to General Ledger section of 

this white paper. 

 

For more information on the DRM to Oracle Fusion General Ledger integration for on-

premise environments, see the white paper on Oracle support document ID 1315694.1, 

Hyperion Data Management Integration with the Oracle Fusion and E-Business Suite General Ledgers. 

 

 

For more information on the DRM integration with Fusion General Ledger, see the Oracle 

General Ledger Integration Guide for Data Relationship Management. 

 

  

http://docs.oracle.com/cd/E17236_01/epm.1112/drm_install_1112200/launch.html
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Download from General Ledger 

 

You can export chart of accounts and hierarchies from the same task in Oracle Fusion 

Functional Setup Manager that is used for their maintenance. 

 

To complete the export: 

 

 Choose Setup and Maintenance from the Navigator. 

 Find and select the task Manage Account Hierarchies.   

 Select the hierarchy.   

 Expand the hierarchy to find the version to be downloaded.   

 Use the Action option from the search results toolbar and select View Tree 

Version. 

 

 

 

 

 

 

 

 

 

 

 

The page  refreshes to display the hierarchy version.   

 

Use the View menu option from the search results toolbar to expand the hierarchy to 
display the hierarchy details.   
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The export is based upon the selected display. If you want to download the entire 
hierarchy, display all the values. 

 

Select the export nodes icon from the search results toolbar to export the information to a 
file, which you can then save locally and reuse as needed. 

 

Create Files for Upload to General Ledger 

 

Upload chart of accounts and hierarchies to General Ledger if the values are in an external 

system other than DRM, but used by General Ledger. 

 

General Ledger provides two mechanisms to upload chart and hierarchy values.   

 

1. The Rapid Implementation for General Ledger spreadsheet. 

The spreadsheet is used to create enterprise structures, such as the chart of 

accounts structure and ledgers, and to upload chart and hierarchy values. It is 

organized in a business user format, rather than from a technical perspective. 

 

This template is available from the Setup and Maintenance task. Search for the 

task Create Chart of Accounts, Ledger, Legal Entities, and Business Units in 

Spreadsheet, and then select the Go to Task icon. The spreadsheet  opens 

automatically. It includes instructions to guide you through the upload process. 
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Rapid Implementation also provides the ability to just do a hierarchy version even 

where the core enterprise structures are already defined. 

 

2. The Segment Values and Hierarchies Interface spreadsheet. 

 

The spreadsheet is used exclusively for uploading chart of accounts and hierarchy 

values. It is not used to define the chart of accounts structure. The spreadsheet 

includes the ability to enter chart of account value descriptions in multiple 

languages; which is not provided in the Rapid Implementation for General Ledger 

spreadsheet. 

 

This template is available in the Oracle Enterprise Repository (OER), a catalog of 

integration assets for Fusion applications.   

 

Once you have logged into OER, from the main search page, search for these assets using 

the search: Segment Values and Hierarchies Import. Download the spreadsheet. It 

includes instructions to guide you through the upload process. 

 

Upload Files and Import to General Ledger 

 

If you have a .csv file with the chart of accounts and hierarchy values from DRM or the 

Segment Values and Hierarchies Interface template you can manually load the file to 

General Ledger. The same process is used to load .csv files from DRM and for .csv files 

generated by the Segment Values and Hierarchies Interface spreadsheet.   

 

This process does not apply if you are using the Rapid Implementation of General Ledger 

Spreadsheet (which contains its own instructions for upload).   

 

Use the File Import and Export navigation option from the Tools menu from 

applications home page to upload the file. There are screen shots showing the same 

process as used for loading budgets in the section Load Budgets Using Data File Loader.  

 

Once you have navigated to the page, select the create icon from the search results toolbar 

to import a file. Enter the values as follows. 

https://fusionappsoer.oracle.com/
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Parameter Selection 

File The file that you created when you 

completed the template. 

Account fin/generalLedger/import 

 

 Use the navigator to select Scheduled Processes.   

 Select the process, Load Interface File for Import.   

 Complete the parameters as follows. 

 

Parameter Selection 

Import Process Import Segment Values and Hierarchies 

Data File The name of the file that you imported. It 

must be in the account 

fin$/generalLedger$/import$ 

 

Use the process monitor to view the results. Once this import is successful, you can 
import the values. From the scheduled requests page, submit the process Import Segment 
Values and Hierarchies. Although this has the same name as the Import Process described 
in the previous step, it has a different purpose and must also be submitted.   

 
After the process completes, you can view the results using the Manage Account 
Hierarchies task from the setup and maintenance menu. 

 

Upload to Planning 

 
If you are using DRM, load account and hierarchy values to Planning (on-premise) using 
pre-built integrations provided by Oracle. This is described in the Oracle Hyperion Data 
Management EPM Architect Integration Guide. 
 
If you are not using DRM, you can load chart of accounts and hierarchies from General 
Ledger using the Planning data loader. 
 
To load chart of accounts and hierarchies from General Ledger to Planning  
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 Download the values from General Ledger. Each segment (known as a dimension in 

Planning) must be in a separate file. Details for this process are covered in the 

Download from General Ledger section. 

 Reformat the values into the format required by Planning. 

 Use the Planning data loader to upload the chart of accounts and hierarchies. Details 

for this are included in the Load Metadata section of the Oracle Cloud Using Oracle 

Planning and Budgeting Cloud Service documentation. 

 

Upload to Financial Management 

 
If you are using DRM, load account and hierarchy values to Financial Management using 
pre-built integrations provided by Oracle. This solution is available for both the on-
premise. It is described in the Oracle Hyperion Data Management EPM Architect Integration 
Guide. 
 
If you are not using DRM, you can load chart of accounts and hierarchies from General 
Ledger to Planning using the Planning data loader. 
 
To load chart of accounts and hierarchies from General Ledger to Planning  
 

 Download the values from General Ledger. Each segment (known as a dimension in 

Planning) must be in a separate file. Details for this process are covered in the 

Download from General Ledger section. 

 Reformat the values according to Hyperion Financial Management. As part of this, 

you may decide that you would like to use different hierarchies for consolidation than 

are used by General Ledger. Formatting requirement details are located in the Creating 

Metadata Files of the APP Format section of the Oracle Hyperion Financial 

Management Administrator’s Guide. 

 Load the results into Hyperion Financial Management. This is covered in the Loading 

Metadata section of the Oracle Hyperion Financial Management Administrator’s 

Guide. 

http://docs.oracle.com/cloud/latest/pbcs_common/CSPLU.pdf
http://docs.oracle.com/cloud/latest/pbcs_common/CSPLU.pdf
http://docs.oracle.com/cd/E10530_01/doc/epm.931/hfm_admin.pdf
http://docs.oracle.com/cd/E10530_01/doc/epm.931/hfm_admin.pdf
http://docs.oracle.com/cd/E10530_01/doc/epm.931/hfm_admin.pdf
http://docs.oracle.com/cd/E10530_01/doc/epm.931/hfm_admin.pdf
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General Ledger Balances 

This section covers extraction and transformation of General Ledger balances for 

budgeting and consolidation.   

 

 Download balances to a file if there is not a direct connection from General 

Ledger to the application used for budgeting or consolidation.   

 Download balances to a spreadsheet if you are using spreadsheets for Budgeting 

or Consolidation.   

 Transform balances directly in General Ledger if you are using a spreadsheet or 

application other than Planning or Financial Management and the level of balance 

detail is different than is provided by General Ledger. This transformation occurs 

prior to the balance download. 

 Transform balances using FDM if you are using Planning (on-premise) or 

Financial Management and the level of balance detail is different than is provided 

by General Ledger. This transformation occurs after the balances are uploaded to 

FDM. 

 Transform balances using the data loader in Planning and Budgeting if you would 

like to do transformations in Planning rather than General Ledger. 

 

Download Balances to a File  

 
The best way to extract actual balances from General Ledger is by running the Trial 
Balance Report. You can schedule this report to run at a pre-determined interval or 
request it on-demand. 
 
To run this report, choose Scheduled Processes from the Navigator and select the Trial 
Balance Report: 
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In this example, the user has elected to summarize by account, meaning the Trial Balance 

Report preserves the most granular account balances and display a row for each account 

combination. You could choose to summarize by: 

 

 Natural Account, in which case the report would be more highly summarized, with a 

row for each natural account and all other chart of accounts segments summed. 

 Natural Account and Additional Segment, in which case you choose one additional 

segment. The report  includes a row for each combination of natural account and the 

selected segment, with all other segments summarized. 

 

If you only budget or consolidate at the natural account level (or natural account plus one 

other segment), then you should choose one of these options. 

 

If you choose Account, the finished report displays each account combination in a single 

column, for example 01.000.4100.0000.000.  

 

If you want to schedule this report to run regularly, click Advanced and choose the 

Schedule tab: 
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To generate the report as a CSV file, choose the Output tab, and add a row to specify 

Excel (mhtml) as the format.  

 



Oracle Financials Cloud Service and Hyperion Performance Management Applications Integrations 

 

17 

 
 

You can then load this file into Planning and Financial Management. 

 

Download Balances to Spreadsheets 

 
The easiest way to download actuals from General Ledger to a spreadsheet is through 

Smart View. Smart View is an excel add-in for reporting and analysis. If you don’t already 

use Smart View, you can download the add-in from Oracle Technology Network. 

With Smart View, you choose exactly which account combinations you need for which 

time periods and press Refresh. Smart View retrieves your actuals directly into the 

spreadsheet. You can then reference these actual balances. 

Note: It is also possible to use Smart View to enter your budgets. However, this is not 

recommended because, while Smart View loads your budgets to the General Ledger 

balances cube for budget-actual comparisons, it does not backup your budgets. This 

means that, if in the future you need to rebuild your balances cube, your budgets are lost. 

You would have to back them up yourself, outside the General Ledger, and then reload 

them. 

http://www.oracle.com/technetwork/middleware/epm/downloads/smart-view-1112x-1594693.html
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If you have a large chart of accounts, you may find it more efficient to run the Trial 

Balance Report rather than leveraging Smart View. You can submit the report once and it 

generates a report of your entire set of balances. When you run it, you can specify Excel 

as the output option, so that when you open the completed report, it opens directly in 

Excel.   

 

Transform Balances in General Ledger 

 

If you don’t have access to data transformation tools (for example, if you are not using 

Hyperion Performance Management Applications), and need to transform the balances, 

you may want to consider modifying the General Ledger Trial Balance template. This 

allows you to modify the output of the report without customizations or using an external 

transformation tool. 

For example, by default, the Trial Balance Report displays your entire account 

combination, e.g. 01.000.4100.0000.000. Suppose your application does not include that 

last segment. You could modify the Trial Balance template to suppress that final segment. 

To do so: 

 

 Choose Reports and Analytics from the Tools menu in the Navigator. 

 Expand Shared Folders > Financials > General Ledger 
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 Under General Ledger > Trial Balances, click Trial Balance Report and choose More. 

 

 
 

 Choose Edit under Trial Balance Report. 
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 This downloads the Trial Balance template which you can open in your word 

processor. 

 

 
 

This is the template used to control the output of the Trial Balance Report. 

 

There are three tables in this report, one for each of the Summarize by options. In 

other words, depending on which level you choose for Summarize by (Account, 

Natural Account, or Natural Account and Additional Segment), the report uses the 

corresponding table. 

 

In this example, we want to display the overall account combination while suppressing 

the last segment. Thus, we focus on the top table. 

 

 Right-click account and choose BI Publisher > Properties. 
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This displays the tag (<?ACCT?>) used to slot the appropriately tagged data into that 

specific location in the report template. We can use the BI Publisher substring 

capability to only display the first 17 characters of account combinations like 

01.000.4100.0000.000. Replace <?ACCT?> with <?xdofx:substr(ACCT,1,17)?> and 

press OK. 

 When finished, save your template as an .rtf file. 

 Return to your browser and click Properties under the Trial Balance Report. From 

here, you can upload your file as a new template. 
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Then, when you run the Trial Balance Report, simply specify your new template as the 

Output option. 

 

This suppresses the final segment of your account combinations, which may result in 

multiple rows for a resulting combination. Be sure that when you load this file into your 

application, you are able to sum these rows together. 

 

For more information, please refer to BI Publisher on http://www.oracle.com. 

 

Upload Balances to Planning 

 
To upload General Ledger Balances to Planning and Budgeting, save the trial balance 
information to an accessible machine (such as your PC), and then import the data into 
Planning. 
 
Once the file is saved locally complete the following. 
 
Update the file so that it is in the format required by Planning. This can be done prior to 
generating the trial balance described in the section Transform Balances  
Directly in General Ledger. If you instead want to transform the balances in Planning you 
can use Data Management in Planning and Budgeting Cloud Service.   
 
For information on completing the data load in Planning and Budgeting Cloud Service, 
see the Oracle Learning Library, Load Data and Drill Through in Oracle Planning and 
Budgeting Cloud Service. 

http://www.oracle.com/technetwork/middleware/bi-publisher/overview/index.html
https://apex.oracle.com/pls/apex/f?p=44785:24:5996056928368:PRODUCT:::P24_CONTENT_ID%2CP24_PREV_PAGE%2CP24_PROD_SECTION_GRP_ID:8745%2C141%2C1393
https://apex.oracle.com/pls/apex/f?p=44785:24:5996056928368:PRODUCT:::P24_CONTENT_ID%2CP24_PREV_PAGE%2CP24_PROD_SECTION_GRP_ID:8745%2C141%2C1393
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For information on completing the data load in Planning (on-premise) see the Loading 
Data and Metadata section of the Oracle Hyperion Planning Administrator’s Guide.   

 

Upload using Financial Data Manager 

 
If you are using the on-premise Planning or and/or the Financial Management application 

and the balances are not at the same level of detail as your General Ledger chart of 

accounts, then you can load the General Ledger balances as is.   

 

If either application is more summarized, then you  need to transform your extracted 

actual balances to match these applications. If the applications use different levels of 

summarization the process is the same, but is completed once for each application using 

the appropriate summarization levels.   

 

The best way to transform extracted actual balances for use with on-premise Planning or 

Financial Management is with Financial Data Quality Management, Enterprise Edition 

(FDMEE).    

 

 

 

http://docs.oracle.com/cd/E17236_01/epm.1112/hp_admin_11122.pdf


Oracle Financials Cloud Service and Hyperion Performance Management Applications Integrations 

 

24 

 
 

For more information on FDM, please refer to the FDM section of the Oracle 

Documentation Library. 

 

Upload using Financial Management Data Loader 

 
If you would like to bypass FDM and load the actual balances file directly into Financial 

Management, you can do so. However, the balances file must be formatted as required by 

Financial Management. Details for this are covered in the section on Managing Data in 

the Oracle Hyperion Financial Management User’s Guide. 

 

 

 

 

 

 

http://docs.oracle.com/cd/E40248_01/nav/portal_6.htm
http://docs.oracle.com/cd/E10530_01/doc/epm.931/hfm_user.pdf
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Budget Amounts 

 

This section covers how to load completed budgets to General Ledger. There are two 

mechanisms which can be used for this purpose. 

 Spreadsheet loader: This is useful for low volume budget data that is easy to 

manipulate in a spreadsheet.   

 Data file loader: This is useful for large volume budget data not easily manipulated in a 

spreadsheet. It is also useful if you update and reload budgets frequently to General 

Ledger. You can schedule this process to run as needed. 

 

If you are using Planning, and the level of detail from budgeting to General Ledger 

differs, you can define transformation rules using FDM. This is similar to the 

transformation process described in the section on General Ledger balances. If the 

transformations are very simple this may not be necessary.   

 

Review Budgets in Planning Prior to Load 
 

If you are using Planning, you can use its Budget Review feature to verify the budgeted 

amounts before loading them to General Ledger. 
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In this example, budgeting is at a high level, based primarily on Entity and Natural 

Account. To load your budgets to General Ledger, you need to map this high-level budget 

data to the chart of accounts you use to track your actuals.   

 

 For any segments in your chart of accounts that are not represented in your budget 

(for example, cost center), specify a default value. 

 For any segment values that represent parents in a chart of accounts hierarchy, specify 

a corresponding child value. This is necessary because in General Ledger, parent 

values represent points of aggregation. Journals should not be directly posted to them. 

 

Download Budgets from Planning 

 
You can download budget information from Planning directly into Excel; and then 

reformat as needed to load into General Ledger.   

Information on downloading budget amounts into Excel is covered in the Exporting Data 

to Microsoft Excel section of the Working with Planning for Oracle Planning and 

Budgeting Cloud Service document. 

http://docs.oracle.com/cloud/latest/pbcs_common/CSPLU.pdf
http://docs.oracle.com/cloud/latest/pbcs_common/CSPLU.pdf
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Defining Budget Scenarios in General Ledger 

 

Prior to uploading budgets, you must define a budget scenario in General Ledger. You 

can maintain multiple budgets or forecast versions simultaneously using a separate 

scenario for each. You can reference any scenario in a variance report. 

 

To define a budget scenario: 

 

 Choose Setup and Maintenance from the Navigator. 

 Go to the task Manage Value Sets. 

 Search for value sets for the General Ledger module. 

 Choose the Accounting Scenario value set and click Manage Values. 

 Here you can see any existing scenarios and enter any needed new ones. 
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Load Budgets Using Spreadsheet Loader 

 

To use the spreadsheet loader: 

 

 Choose General Accounting Dashboard from the Navigator. 

 From the Task pane on the left, choose Create Budget in Spreadsheet. This creates a 

blank spreadsheet with columns for your chart of accounts segments and budget 

amounts. 

 

 

 Enter a Run Name to distinguish this budget load from other loads. 

 Enter the Name of the budget you are loading. This is the scenario you created in an 

earlier step. 

 Copy and paste the budget data from your Planning file into this spreadsheet. You can 

specify any additional segment values (or change any values as needed) simply by 

typing in the appropriate columns. 
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 When you are ready, click Submit at the top of the worksheet. 

 

Load Budgets Using Data File Loader 

 

To use the data file loader: 

 Make sure your exported file is in the format expected by the data file loader. The 

exact file format is available in the Oracle Enterprise Repository. 

 Choose File Import and Export from the Tools menu in the Navigator. 

 Click the New button in the toolbar. 

 

https://fusionappsoer.oracle.com/oer/com.flashline.cmee.servlet.enterprisetab.Download?path=rep%3A%2F%2FR8_FBDI_STORE%2Fxlsm%2FGeneralLedgerBudgetBalanceImportTemplate.xlsm
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 Click Choose File to locate the file. 

 Choose fin/budget/Balance/Import for Account. 

 Click Save and Close. 

 Choose Scheduled Processes from the Tools menu in the Navigator. 

 Run the process Load Interface File for Import. 

 Select Validate and Upload Budgets for the Import Process. 

 Choose your file to complete the File option. 
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After this completes, please run the process Validate and Upload Budgets. Specify the 

Run Name you included in your budget file. 

 

If you frequently update budgets in Planning and wish to schedule a regular process to 

load updated budgets to General Ledger, you can schedule these jobs to run automatically 

at a set interval. In this case, be sure to always name your budget file using the same 

filename.
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